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1. LIO-8 Quick Start Guide

Figure 1.1: LIO-8

Prepare the unit for use
Unpack the LIO-8 and make sure all the parts are there:

• One LIO-8 unit
• One IEC Power Cord appropriate for your area
• One 24-volt 48-watt world-ready external power supply
• One 30” IEEE 1394 9-pin to 6-pin FireWire Cable
• One 4.5 meter IEEE 1394 9-pin to 6-pin FireWire Cable
• Two Rack Ears w/ fasteners
• Rubber feet
• Configuration jumpers
• MIO Software CD-ROM
• Warranty/Registration Card

Bask in the look and feel of the LIO-8! Once you’re finished, connect the power supply. Now connect your
input and output cables along with your monitors and signal sources. Your monitors should be connected to
Analog Out 1/2, either via a DB25 cable or the 1/4" TRS jacks. Turn the unit on using the front panel switch.
Cool, isn’t it?
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Figure 1.2: LIO-8 Routing

Connect the LIO-8 to your computer
Go to your computer and install the MIO Console and driver from the included disc (this will require a restart).
Connect the Firewire cable between the LIO-8 and your computer, then go to the System Preferences and
select it as the system’s sound input and output.

Get familiar with the front panel
Look at the LED under the Monitor Control encoder; the “Monitor Control” LED should be illuminated. If
“Cans” is lit, push the encoder to switch it (all encoders have shaft buttons). The LED should be green; if it is
yellow, push the “Dim” button. If it is red push the “Mute” button. Now that you’re sure that you’re looking at
the Monitor Controller and that is not dimmed and unmuted, turn it down. The meters are now showing the
gain value of the Monitor Controller. This will happen any time you adjust an encoder.

Take a listen
Now we’re ready to listen. DON'T LAUNCH MIO CONSOLE YET! Open iTunes and play some music. Turn
up the Monitor Controller to a comfortable level, then try the Dim and Mute buttons again. Next, connect a
pair of headphones to the front panel. Push the Mute button to turn off your monitors, then press the Monitor
encoder. Turn the level down (you’re now controlling the headphone amplifier), then put on your cans and
turn up the encoder.

The MIO Console
Once you’re comfortable with the Monitor Controller and how it works, quit iTunes and let’s get ready to do
some work. Launch the MIO Console. You’ll be asked to select a template; select “LIO-8 Basic Setup” which
will give us a simple starting point. Take a look at the panel on the right- it outlines what the templates do.
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Figure 1.3: Template selection pane

Next open the application’s preferences. Turn off “Legacy Support” (this is for older boxes), and turn on “Use
Open GL for rendering” if your computer supports it. Hit OK, then quit and relaunch MIO Console.

You’re now presented with the Mixer window. We’ll come back to this in a bit; for now go to the “Window”
menu and select “MIO Console: LIO-8 Basic Setup”.

Figure 1.4: Console window

There are a few important things to look at here. To the right, the “System” column lets you set the clock
source, sample rate and whether the wordclock output is 1x or 256x rate. In the “Lock” column you can see if
the LIO-8 is receiving a valid clock on the selected source and use the “DI” buttons to select which AES input
pair should be used as a clock source if you are clocking via “Digital”.

Toward the top of the window you will see the text “LIO-8/xxx” where “xxx” is the serial number of the box.
By clicking on this you will get a menu of options, including “Front Panel Prefs”. If you select this you will
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bring up a pane that will let you tailor the front panel to your liking. You can also remove offline boxes (you
shouldn’t have any at this point).

The I/O Control tab has metering and control for the analog I/O. You can link stereo pairs, set operating levels
and gain. The I/O Control tab is synchronized with the Front Panel; changes in one place are reflected in the
other. There is also metering for digital I/O. If you click on the +DSP tab, you have access to a “Virtual” DSP
area. Next is the “Recording” tab. Any channel that is assigned to a “FW” channel via a direct out or bus
output is available for recording via MIO Console’s record engine. Since the template you loaded has these
assignments made, they are shown here. More detailed instructions on the Record Panel are available in the
documentation. You can find the documentation on the CD, and it is also accessible directly from the Help
menu in MIO Console.

The Mixer window

Figure 1.5: Mixer window

The Mixer window presents you with a familiar interface to the LIO-8. At the top of every channelstrip is a
pulldown list of available sources. For analog inputs you can select the input type, enable phantom power
and set gain. Below the head-amp area is the Character menu. This lets you select any of our DSP based
circuit emulations for your inputs, busses and outputs. Some are very subtle, so you may want to try different
Characters on different signals. Next is a pre-insert direct out. This lets you route the channelstrip to any unused
analog or digital output, as well as to “FW” channels. The FireWire channels allow you to return audio from
the LIO-8 to your computer.

Below Character are the insert slots. Here you can insert plugins, route to sends (additional busses), call up
macros (pre-made DSP processors) and instantiate graphs. A graph is a “DSP playground” where you can build
your own signal processing chains and save them for later recall. You’ll notice that there is another direct
out under the inserts- this one is post-insert. Any signal routed from this direct out has all of your inserted
processing applied, whereas the pre-insert direct out doesn’t.

The pan control reconfigures depending on the type of channel and the bus that it is assigned to:

• There are no pan controls on a channel assigned to a mono bus.
• Mono input channels will have a pan knob when assigned to stereo or LCR busses.
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• Mono input channels assigned to LCRS through 7.1 busses will have joysticks. Right clicking on the
joystick will allow you to hard assign the input channel to a specific output channel, i.e. Center.

• Multichannel inputs (stereo and above) have no pan control.

Every input channel has a phase reverse button, as well as solo, mute and record enable (active if assigned to
FW). The names of the faders can be changed in the “Configure Mixer” pane available from the Mixer menu.
Finally, the pulldown menu at the bottom of the strip lets you assign the input to any available bus.

If you go to the Window menu and select “Show Monitor Control Window” you will be presented with our
software Monitor Controller. It is highly flexible, and controls the analog level control in the LIO-8. There is
a wealth of knowledge in the MIO Console documentation (available from the Help menu) on how to set up
and use the Monitor Controller.

You should now be in a good position to fire up a native DAW and put the LIO-8 through its paces. Select the
LIO-8 as your audio interface; the analog inputs will be inputs 1-8, digital inputs will be 9-16 (as determined by
the FW channel assignments). Send your DAW’s signal to outputs 1/2 and it will come into the LIO-8 on DAW
1/2. By using the FW channels to send audio to your DAW and the DAW input returns from your computer
you have a virtual patchbay to route audio between your DAW and the LIO-8.

The LIO-8 and surround
If you’re working in surround, it’s easy to configure the LIO-8 for monitoring and processing. Go to the Mixer
menu and select “Configure Mixer”. At the top of the pane you’ll see the “Main” bus, which is stereo and a
Master. Master busses are routed to outputs, while Aux busses are routed back into Master busses (for returns,
subgroups, etc. ). If you click on the bus type you can change it from “Stereo” to whatever width you need ;
let’s say you’re working in 5.1. Select “5.1” and hit configure. Voila! All the mono channels now have joysticks
instead of pan knobs, and the Main bus is automatically routed to Analog 1-6. Your DAW is still coming in on
two channels, but that’s easy to change. Go to the top of the DAW 1/2 channelstrip and click on the assignment
pulldown. You have the choice of a mono channel, or a 6 channel strip. By selecting DAW 1-6, your audio will
come into the LIO-8 as positioned by your host. Your other choice would be to make this channel mono, and
add five more channelstrips via the Mixer menu. This way you can position your audio with the MIO Mixer.

Figure 1.6: Surround mixer
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To make it easier to monitor in surround, let’s use the Monitor Controller. Click on the assignment pulldown at
the bottom of the Main bus and select “N/C” to remove the assignment to the analog outs. Now hold down the
shift key and click the pulldown again; the Main bus was “multed” to the headphones in the template which
means it was routed to Analog 1/2 and the Cans at the same time. Now that we’re working in surround, the
Cans aren’t as useful. By holding down Shift and clicking on the Cans-Digital 4 line, we clear the mult. Now
click on the pulldown one more time and select “Add to Monitor Controller”. Go to the Window menu and
select “Show Monitor Control Window”.

The Monitor Controller shows the Main bus is the Monitor Source, but we need to define an output. Click the
“Configure” button to open the MC pane. Click “+” under Monitor Paths and you’ll have the option to add a
Monitor Output. Give the path a name (like “Surround”) and select 5.1 as the bus type. Now you can assign
your output channels. If you want to select your outputs sequentially, a shortcut is to hold down the Option
key when selecting the first channel. For example, hold down Option and click the assignment for the Left
channel and select Analog 1. The rest of the channels will fill in automatically. They default to Monitor level,
which is optimized for connecting to self powered monitors or amplifiers. If you are connecting to another
device like a mixing console you can change this to Line.

Figure 1.7: Configuring the Monitor Controller

Choose "OK" and you now have a surround monitor controller!
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Figure 1.8: The configured Monitor Controller

Unleash the DSP
Every LIO-8 is based on the 2d processing card and may be purchased with an optional +DSP license. The
+DSP can be added by the user at any time; if you purchased a unit with the +DSP license, it is preinstalled
in the hardware and ready to go. This gives you powerful processing in the box, and the ability to work with
processing and monitoring whose latency is equivalent to the converter overhead.

There are two ways to access the DSP:

• You can insert processes directly in the mixer strip inserts; this works well for standalone processes like
eq, compressors, etc.

• Insert a graph. +DSP ONLY This lets you chain plugins together, use them in parallel, and create con-
figurations that would be difficult (or impossible) with other platforms.

You should definitely check out the following processes:

• MIOStrip: Gating, EQ and compression powerhouse.
• Character: The sound of different analog circuits and devices available on any input, output or bus.

Some can be subtle, so stack them across an entire mix. Try SoftSat on your main bus; you'll like it.
• Haloverb: Great sounding reverb, doesn't use any CPU from your host. What's not to love?

This should get you started with the LIO-8!

Additional Resources

Where is the manual?
Full documentation can be found in the Help menu; selecting "MIO Console Help" will open the "Mobile
I/O Users Guide" pdf in Preview, where it can be read and printed.
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The LIO-8 is an exceptionally deep product, and there are many features, applications and workflows to
discover. We have published a series of technical notes and tutorial movies that go in depth about the Mobile
I/O platform. Please take a look at them to learn more about the LIO-8:  http://www.mhsecure.com/technotes

http://www.mhsecure.com/technotes
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